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Computer Technology 

Assignment 1 
Microsoft Excel 2007 

 
1. Go to Student Common/Computer Technology/Spreadsheets/Assignment 1. This will open up a Word Document. 

Go to the website indicated on the sheet: http://www.usd.edu/trio/tut/excel/index.html. This is a basic tutorial on 

Excel and on Excel vocabulary, which will be what is on the final at the end of the semester.  

2.  Print a copy of Assignment 1, then answer the questions on it as you go through the tutorial.   

3. At the end of the tutorial there will be a quiz. Take the quiz, and print the results.  

4. Staple your quiz to the tutorial and turn into the basket when finished. 

 
Computer Technology 

Assignment 2 
Microsoft Excel 2007 

 
1. Open Student Common/Computer Technology/Spreadsheets/Assignment 2. Here you have the nutritional 

information for some of the items on the menus of various fast-food restaurants.  

2. First we are going to move the contents in Cell A2 into A1. Click on cell A2. Place your cursor on the 

EDGE of the cell so that it turns into a four-sided arrow. Then drag it up one cell, into cell A1. 

3. Now lets make column A wider so we can see the contents easier. Place your cursor between 

the A and B so that it turns into a two-sided arrow. Double click. 

a. The column should automatically re-size to the length of the longest word in that column. 

4. Highlight Row 1. Right click on the area you have highlighted and choose Insert from the menu. 

a. In the new A1, type the title ―Nutritional Facts‖ 

b. Highlight cells A1-F1 and press  

c. Change the font size to 18. 

d. Change the color to a color of your choice by clicking on the  button. 

e. Change the font to a readable font of your choice. 

5. Now highlight cells A2-F2. 

a. Change the color of the fill to yellow by clicking on the  button. 

b. Change the font to 14. Bold it by clicking on the  button. 

6. Now highlight row 18. Right click and Insert. 

a. Highlight A19-F19. 

b. Change the color of the fill to red, the size to 14, and bold it.  

7. Now we need to copy and paste the information from sheet 2, for Burger King. 

a. Click on Sheet 2 at the bottom of your screen.  

b. Highlight cells a A1-F16. Copy it by pressing CTRL+C, pressing  from the home 

ribbon, or right click and choose Copy from the menu.  

c. Go back to Sheet 1. Place your cursor in cell A36. 

http://www.usd.edu/trio/tut/excel/index.html
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8. Now highlight cells A19-F19. Choose  from the home ribbon. 

a. Highlight cells A36-F36. You have now copied the format to the 

new cells.  

b. Change the fill color to blue. 

9. SORT. Highlight cells A3-F17.  

a. Go to the Data Ribbon. 

b. Click on the sort button. 

c. Pull down the sort by menu, and choose 

Calories from the list. 

d. Now highlight cells A20-F34. Sort this one by size. 

e. Highlight cells A37 – F51. Sort this one alphabetically. 

10. Now highlight rows 4-17. Change the font to 8. Do the same for rows 

21-34, and rows 38-51. 

a. Double click between the A and B again to resize column A, 

now that the font is smaller. 

11. Highlight cells A3-F17. Click on the borders tab and choose All Borders. 

a. Do the same for cells A20-F34, and A38-F31. 

12. Highlight cells B3-F3.  

a. Right click and choose Format Cells. Click on 

the Alignment tab. Change the orientation to 

45 degrees. 

b. Do the same for cells B20-F20. 

c. And again for cells B37-F37. 

13. Now we are going to insert some pictures. Go to the 

internet, and to Google Images. In the Image search, 

type ―McDonald’s Logo.‖  

a. Find a logo that is rather small. Click on it, 

then go to See Full Size Image. Right click and save this logo into your My Pictures folder.  

b. Find a logo for Wendy’s and for Burger King. 

c. Go back to your assignment and click on Insert, then Picture. Find the McDonald’s logo, and 

insert. Place it  roughly in column G. Do the same for the other three logos. 

14. Add a header. Go to the Insert ribbon, and choose Header. Type your name in the left column, and 

Assignment 1 in the middle column.  

a. Go to View, and choose Normal to get back to your original view. 

15. Check to make sure that your document is only 1 page long.  

a. Click on the Office button, go to print, and then print preview. Check the bottom of the page to 

see that it says page 1 of 1.  

b.  If it isn’t, go to Page Layout, Margins, and change the margins to Narrow. If it IS only one page, 

you are ready to print. 

16. Make sure you SAVE this document in MY DOCUMENTS. Then print it and turn it into the basket. 
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Computer Technology 

Assignment 3 
Microsoft Excel 2007 

 
1. Open Microsoft Excel. Choose Assignment 3 from the Spreadsheet file in Computer Technology. 

2. Now you will sort the gymnasts, first by county, then by name.  

a. Highlight cells A2-G23. Go to the Data ribbon, and choose sort. 

b. In the pull down menu next to Sort By, choose Country. 

c. Click Add level.  In the next 

pull down menu, choose 

name. 

d. Press ok. 

3. Highlight cells A2-H2.  

a. Go to the Home Ribbon and 

choose Wrap Text from the 

menu. 

b. Underline cells A2-H2. 

4. Highlight A3-A23. Right click and choose Format Cells.  

a. Click on the Alignment Tab. 

b. Click to put a check mark next to Shrink to fit. 

i. Now the names should all fit, without you having to widen the column. 

5. Highlight cells C3-H3. Click on the  button in the Home Ribbon. You now have a total for 

Jade Barbosa. 

a. Now try it again with Fei Cheng’s scores.  

b. Once you have done it a few times, review using autofill. Highlight cell H4 and put your 

cursor on the lower right hand corner until it turns into a black plus sign. Drag down to row 

25. 

6. Now highlight cells C3-C24. Use the  button again to total the scores for uneven bars. Do 

the same for all the other events. 

7. Time to find the Average. You have to be careful because you do not want to calculate the Total 

into the average! 

a. Put your cursor in cell C25. Type =Average(            (include the open parenthesis!) 

b. Then highlight cells C3-C23. NOT the total. You should get 16.179 as your answer. If you 

got a much higher number, that is because you calculated the total with it.  

c. Now do the same for each of the events. 

8. Formatting – Highlight cells A24-H25. Change the background color by clicking on the  

button. 

a. Do the same for A2-H2.  

b. Highlight A1-H1. Click on the Merge & Center button.  

c. Change the font to 16 and choose a readable font of your choice. 

d. Highlight cells A1-H25. Change the borders to All borders. Then choose 

Thick Box border from the list. 

9. Add a header and print. Turn into the basket.   
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Computer Technology 

Assignment 4 
Microsoft Excel 2007 

 
1. Go to Computer Technology/Student Common/Computer Technology/Spreadsheets/Assignment 4. 

2. This is a list of Student Loans from Summer Ridge Community College. Make the following changes 

to the look of the sheet: 

a. Highlight A1-I1 and center across using the button. Do the same to A2-I2. 

Change the font size to 18 pts. Change the font to Times New Roman. 

b. Highlight A3-I3. Click on the  button. With the cells still highlighted, center  

them. Then Underline. Change the shading to gray. 

3. Double click between the A and B to widen column A, so you can see all names. 

4. Now you will be changing the format of several of the columns.  

a. Highlight column B. Right click and choose Format Cells. On the Number tab, choose Special, 

and Social Security Number. 

b. Highlight column C. At this school, account numbers are formatted as ####-##. You will have to 

do a custom format.  

i. Go to Format Cells, and choose Custom. In the Type box, type ####-## and press ok.  

c. Highlight column D. Press the  button to change the format to money. 

d. Highlight column E. Go to Format Cells, and choose Date from the Category list. Choose 

03/14/01 format. 

i. Double click between the E and the F to resize column E.  

ii. Resize any other column that needs it. 

5. Now we will calculate the monthly payments required by each account, in the F column. 

a. Place your cursor in cell F4. The minimum due is determined by one payment every 12 months 

for ten years. This is really TWO math problems, but it can be done in one formula as follows: 

i. Type the first problem—the amount due divided by 10 years (which tells you how much 

they must pay EACH YEAR) into parenthesis. Then divide that by 12—the 12 months of 

one year. It should look like this:  =(D4/10)/12. If you did it right, you should have a 

minimum payment due for Bethanne Arne of $165.54. 

b. Now you will calculate the interest for each payment and add it to your total. Again, this is TWO 

problems you will put in one formula. First, the amount due * the interest, and then that total 

added to the amount due. It should look like this: =(F4*G4)+F4. If you did it right, your answer 

should be $172.99. 

c. Now that you’ve done the math,  you can use Auto Fill to pull down the answers to all the 

problems. 

6. Sort – Currently the names are sorted by name. We want to sort them by account number.  

a. Highlight cells A3-I31. Go to Data, Sort. Sort by Account number and press ok. Tabithah Garland 

should now be the first name on the list. 

7. Filter – Now you will use a filter to answer the questions on the Questions Worksheet.  

8. Highlight cells A3-I31 and click on Filter. Now there are pull down arrows on each row. 

a. Click on the Questions worksheet and answer the questions using your filter. 

b. When you are trying to find an answer, make sure you are filtering the right column. When you 

are finished, make sure you pull down the arrow again and choose ALL to show all listings again.  

c. To get these answers, you will be using Sort A-Z and Number Filters as well. Make sure you test 

them out! 

9. When finished, add a header to both pages and print both. Staple them and turn in to the basket. 
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Computer Technology 

Assignment 5 
Microsoft Excel 2007 

 

You are a teacher’s aide at Elk Ridge Middle School. Your teacher has asked you to record grades for 

one of her classes. You are to list the assignments and test, compute the total points for each and 

calculate the percentage and assign the grade. 

 

1. Key in the worksheet below. Be sure to add a Header with your name, period, and 

assignment number. 

2. Add a first name for each of the last names given. After keying in the column headings and 

column A, add gridlines with the border key. 

3. Widen columns to accommodate all entries (do not cut off any information). Use auto sum to 

find the totals in column F.  

4. To find percent in cell G5, divide the total by the points possible—180.  

a. Format column G to a percent by highlighting the cells and press the  button from the 

tool bar.  

5. Sort the students and all information about each A-Z. 

6. In cell B17, find the average by using the =AVERAGE( function. Enter the cells to be 

averaged between the parenthesis. Auto fill the formula across. 

a. Ex: AVERAGE=(B6-B15) 

7. In cell B18, find the maximum score by using =MAX(. Enter the cells to be maxed between 

the parenthesis. Don’t include the point totals in your cell range! 

8. In cell B19, find the minimum score by using =MIN(. Enter the cells to be min between the 

parenthesis.  

9. Format the document to look like the one below. Print preview, print, and turn into the 

basket. 
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Computer Technology 

Assignment 6 
Microsoft Excel 2007 

 

Open Microsoft Excel. Open Student Common and choose assignment 7. 

1. Type in the information from the in-class survey. If you were absent that day, use the 

information given below. 

2. Before making the charts, right click on the Assignment 6 tab. Choose Insert>Worksheet.  

3. Title the new worksheet ―Graphs‖ 

4. You will make four graphs for each survey, as indicated below: 

a. Birthdays – Column 

i. Highlight cells A4-B15. Go to the Insert tab and choose Column 

from the list. Choose a style. 

ii. In the data section of the Design tab, choose Switch Row/Column. 

iii. In the Chart Layouts choose the center option.  

iv. Change your chart title to Birthdays.  

v. Highlight your graph and choose move chart from the toolbar. 

Select ―Graphs‖ from the pull down menu. Arrange the chart on the 

new sheet you created. 

b. Grades – Line (if you don’t remember, guess!) 

i. Highlight cells D3-F15. Create a line chart. Follow the same steps 

you did for the Birthday chart, giving it a title and moving it to the 

graphs tab. 

c. Favorite Junk Foods – Pie 

i. Highlight A22-B26. Follow the same steps, creating a column chart. 

d. General Survey – Bar 

i. Highlight D19-G28. 

ii. Follow the same steps, adding a title and moving to the graphs column. 

5. Print only the graphs page. Make sure 

all of them fit on one page using print 

preview. Add a header and print. 

 

 

 

If you are absent the day we do this in class, 

use this information 
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Computer Technology 

Assignment 7 
Microsoft Excel 2007 

 
1. Today you will be creating a graph in Excel which will show the popularity of your name and other 

names that are meaningful to you. NOTE: If you have a very unusual name that is not on the list at all or 

very little, you may select any other names of your choice for this assignment. Please open up a blank 

page in Excel. 

2. Now, go to the Social Security website. This site tracks the top 1,000 names each year going way, way 

back. The site is: http://www.ssa.gov/OACT/babynames/.  

3. You will see a section telling last year’s top ten 

names. Below that, is the specific name selector.  

Enter your name, or the name you would like to graph, 

in the space provided. Indicate the gender. On number 

of years, enter about 110, or far enough back so that 

the year 1900 will appear. 

4. You now will see a list of each year and what the 

name you entered ranked each year. If the rank shows 

a, that means that it was not in the top 1,000 for that 

particular year. 

5. Now we will graph it. Because this graph is going to show change over time, 

we are going to create a line graph. First we need to enter the information.  In a 

column, enter the years 1900, 1920, 1940, 1960, 1970, 1980, 1985, 1990, 1995, 

2000, 2005, and the most recent year. Then, enter the rank for each year. If that 

particular year does not have a rank, leave it blank. Your information should 

look something like this: 

6. Graph it. Highlight the information, and choose a line chart from the Insert 

menu. 

a. Most likely, you got a chart that looks like the one below.  

b. SOMETIMES, this doesn’t happen. In the chart below, Excel 

recognized that the years 1900-20-- are YEARS and not just numbers. 

If your chart does not look like the example, you will need to reformat 

the years so that Excel does not treat them as numbers. 

i. To do this, highlight your years entered. Right click and choose 

Format Cells.  In the number list, choose Text. 

c. If your chart DOES look like the one below, do not follow the above 

step. 

7. Now, this chart is ok, but there are many things we can do to make it more meaningful. 

8. When making a chart, you want to make sure that the data you 

are trying to present is clear and meaningful. This chart as it is, 

is misleading. At first glance, it looks like the name ―Molly‖ 

was extremely popular in the 1900’s, and then died down by 

2008. This is not quite true.  It became MORE popular as time 

Example 1 

http://www.ssa.gov/OACT/babynames/
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went by.  We need to reverse our dates, so that the high points of the line indicates high popularity There 

are two ways to do this:  

a. You can either retype in or rearrange your 

dates in the data you entered so that the 

most recent date is on top, 

b. Or you can right click on the axis (the 

numbers lining the left side) and choose 

Format Axis. Then just check the box that 

says ―Values in reverse order‖ 

c. Choose one of these options, or try both. 

In my example, I will do the second 

option. 

9. Now your graph more accurately shows the 

popularity of the name. But there is still a problem. The 

graph makes it look as if Molly was not at all popular in 

1900, and increased rapidly after 1970. This is not quite true 

either—because our Axis is off. Remember that we are 

looking in the top 1,000 names—and Molly starts at 411. 

Therefore, it was moderately popular in 1900, not at the 

bottom of the list.  

a. To fix this problem, right click on the left 

axis, and choose Format Axis. You will see a dialogue box 

appear like the one above.  

b. Next to Maximum, click on the ―fixed‖ circle. Then change the amount to 1,000. Then click 

Close. 

c. Now the graph is a better representation of the 

name. 

10. Highlight your chart and go to Chart Tools. Change the 

layout to Layout 1, as shown. 

11. Now, I have assumed in this example that you have 

chosen a name that has data for each of the years given. It 

is very possible that the name you choose will not have 

existed in 1900, or it will have periods where it does not 

show up on the list at all. I will address these problems as 

well as we add three more names to our chart. 

12. Choose three more names and list them and their data next to your first 

name. You may want to select family members or friends, names that 

mean something to you. They will not yet have any impact on your first 

graph. Go back to the Social Security website and enter the name on the 

left side and select Go. Then enter the information. Again, if the name 

has no data for particular year, leave it blank. 

Example 2 

Example 3 
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13. I have chosen to enter the names Ashley and Chloe. Notice that Ashley 

did not appear until the 60’s, whereas Chloe was unpopular for several 

decades and then reappeared.  

14. To add these names to your graph, do the following steps: 

a. Highlight your graph. Note that your data has colored lines 

around it.  

b. Put your cursor on upper right hand corner of the green section, 

so that your cursor turns into a two-sided arrow. Then pull the 

lines over to encompass your new columns. 

c. Now the new information was added to your 

graph. 

15. Now we still have problems. Notice that for Chloe, the line 

just disappears then reappears. For Ashley, it appears 

suddenly. Keeping the cells blank for the years the name 

does not appear makes this graph more confusing. 

a. What if we just enter zero? Try it. 

b. This fills in the gaps, but it also makes it look as if 

the name was really popular those years, instead of 

not appearing at all. 

c. Ideally, we would enter the rank for those names, even if they are below 1,000, but we do not 

have that data. So now, try entering 1,000 into 

those blanks. 

16. This makes the graph look more accurate. Although these 

names were NOT ranked at 1,000 those years, the graph 

still indicates the sudden rise in popularity for these names. 

17. Make sure you go back to the chart format, as you did in 

step 12, and change the formatting back. Your title should 

be Name Popularity and then below that, Top 1,000 

Names. Change the size of the subtitle to 12. Change the 

left axis to read Rank. 

18. If you feel it is necessary, depending on the data you have, you could also change the years to be more 

accommodating. If you want to change the years so that your year of birth is represented, do so. Or if all 

three names you chose do not appear until later, 

there is no reason to start in 1900. These are 

changes you make to make this graph more 

meaningful. That is the purpose of a graph! 

19. You can also right click on various parts of the 

graph and re-format the color, fill etc. You can add 

more names if you want as well. When finished, 

your graph should look something like this: 

20. Add a header, print preview, and print. 

 
  

Example 4 

Example 5 

Example 6 
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Computer Technology 

Assignment 8 
Microsoft Excel 2007 

 
Create graphs with the sets of information given. All information comes from actual sources.  You 

must organize it yourself in Excel and choose the graph that best describes that information. You 

will be graded on how easily you can read your chart. Questions are provided to help you know if 

your chart is readable—if you cannot read the information, rearrange your chart! 

 

Label each sheet Graph 1, Graph 2, and Graph 3. Complete each graph with it’s data on a different 

sheet. You will need to print all three sheets, staple them, and turn them in to the basket. 

Remember—you will not get credit if there is no DATA with your graph. I need to see how you laid 

it out. 

Tips: 

 Sometimes you may want to change the SCALE of your chart.  

 Adding VALUES or PERCENTAGES to your chart can make it more readable 

 Labeling the X and Y axis is sometimes necessary. 

1. Michael Jordan PPG 

a. Create a chart that shows Michael Jordan’s PPG over the course of 15 years, beginning 

with 84-85 to 97-98. Then from 01-02 to 02-03. 

b. Compare this to his overall average over the course of those 15 years.  

i. Hint: You will need to calculate his average before you make this chart. 

c. Here are his PPG from84-85 to 97-98, then from 01-02 to 02-03: 28.2, 22.7, 37.1, 35.0, 

32.5, 33.6, 31.5, 30.1, 32.6, 26.9, 30.4, 29.6, 28.7, 22.9, 20.0  

d. Answer these questions below your graph: 

i. How many years did Michael Jordan get above his average? 

ii. What year did he score the least amount of points? 

iii. What do you think the graph is trying to say? 

2. Nutritional Facts 

a. Using the information in Assignment 1, create a graph.  You may use the information in 

any way you wish. Decide what point you are trying to make, and then create a graph that 

shows what you want to say. (Hint: You can choose one single item, you can find 

AVERAGES, you can COMPARE similar items, etc.) 

b. Answer these questions below your graph: 

i. What is this graph trying to show? 

ii. What is significant about the information in your graph? 

3. Civil War Data 

a. Go to http://www.civilwarhome.com/casualties.htm, or pull up the file in Student 

Common/Spreadsheets/Assignment 8 – Civil War. 

b. Using the information in this article, create a graph. There are TONS of different angles 

you can take with this—make sure that your graph makes sense and is saying something! 

i. Extra Credit: Create a 4
th

 graph with actual information you find on the internet. 

Please include the resource (URL) where you found the statistics. 

 

http://www.civilwarhome.com/casualties.htm
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Computer Technology 

Assignment 9 
Microsoft Excel 2007 

 
Open Assignment 9 from Student Common/Computer Technology/Spreadsheets. 

 

1. Highlight cells A1-J1. Click on the  button on the home ribbon to wrap the text. Underline it and 

Bold it. Shade it with gray. 

2. Highlight row 1 and row 2. Right click, and choose Insert from the menu.  

a. You should now have two new rows! 

b. In Row 1, type Hair Dot Net 

c. In Row 2, type today’s date. 

i. Right click on the date and go to format cells. 

ii. In the Number tab, click on date, and choose March 14, 2001 as the format. 

d. Use the  button to merge and center both rows, one at a time. 

e. Change the font to one of your choice for both rows. 

f. Change the font size in row 1 to 18. In row 2, change the size to 12. 

3. Highlight B4-B24. Right click, and choose Format Cells. 

a. Go to the alignment tab, and choose Shrink to Fit. 

4. Now go to D4. We want to find out what a 20% discount on the Original price is.  

a. Type =C4*.25 and press enter.  

b. You now know what 20% of 13.50 is. Now calculate Our Cost, by subtracting the discount 

from the original price: =C4-D4. 

5. Now we are going to markup our price by 50%--that’s how much we charge the customer. 

a. In F4, you will find out what 50% of our cost is.  

b. Finding the percent of a number is on the final, so make sure you know how to do this!!! 

c. In G4, add our cost and the markup together, to get the customer cost. 

6. Now you know your customer cost. We need to charge them a tax of 6%. So this time, you will 

multiply the customer cost by 1.06.  

7. In column I is listed how many of each item were sold. We need to figure out our profit. 

a. In J4, multiply the amount sold by MARKUP, NOT by customer cost. 

8. Now let’s sort this list by Profit. Highlight cells A4-J24.  

a. Go to Data, and sort it by Profit. 

9. In A25, type Totals. Then sum the totals for all the columns.  

a. Highlight the cells A25-J25 and change the shading to gray. 

10. Highlight cells A4-J25. Add All Borders to it. Then highlight cells A1-J25, and choose Thick Box 

Border from the list. 

11. Go to the Page Layout Ribbon. Choose Orientation and then Landscape. 

12. Highlight rows 4-25 and change the font size to 10. 

13. Print preview and ensure that the whole document fits on one page. If it doesn’t, resize some 

columns to make it fit. 
14. Add a header, Print, and turn into the basket. 
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Computer Technology 

Assignment 10 
Microsoft Excel 2007 

 
 

Open Assignment 12 from Student Common/Computer Technology/Spreadsheets. 

 

You have just gotten your first job after graduating from college.  You are single without children. You 

are making $35,000 a year.  

1. Open Excel and open Assignment 12. 

2. Fill in the Income section.  

a. Type your yearly wage in the space provided. 

b. Divide that by 12 months to get your Gross Income. 

c. Multiply your gross income by .25% to calculate taxes. 

d. Multiply your gross income by .10% to calculate insurance 

and retirement. 

e. Subtract taxes and insurance from your gross income to 

calculate your net income per month. 

3. Fill in information for monthly expenses. 

 

 

Rent          Car 
 

Mansion  $4,000 per month  Sports car  $500 per month 

House   $1,200 per month  High-end car  $450 per month 

Townhouse  $1,000 per month  Middle-level car $300 per month 

Apartment  $600 per month  Low-end car  $200 per month 

Shared Apartment $250 per month  Clunker  $100 per month 

Live at home  Free    Bike   $10 per month 

Bus pass  $10 per month 

 

Groceries 
 

Full stock, no help from home,  $200.00   Extras 

  lots of food and treats      

Less food, no help from home,  $150.00  Jet Skis $300 per month 

  less treats.    Boat  $400 per month 

The bare minimum $100.00   Snowmobile $200 per month 

Live on parents (only if at home) $50.00  Horse  $900 per month 

 

Utilities – Pay 30% of your house payment. Ex: =1200*.30 

Car Payment – Pay 75% of your car payment. Ex: =300*.75 

Gas – Pay 15% of your car payment. 

Entertainment – You decide how much you would spend a month on movies, CD’s, etc. 

Student Loans – You must pay a minimum of $50.00 a month. You may pay more if you choose. 
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Credit Cards – You have a balance of $1,000 on your credit card. You choose how much to pay per 

month. 

Savings – This is optional—you choose how much to put in each month. 

 

4. Now do a six month budget of your expenses. You must have at least $100.00 left over at the 

end of each month. If you do not have $100 left over each month, change your expenses until 

you can afford it. 

5. In cell E18, sum all expenses by adding cells E6 to E17 using Autosum  

6. In cell E19, subtract your expenses from your income. The remaining amount will 

automatically be added to next month’s income. 

7. Now for August,  your math is slightly different. In F18, total your expenses again. 

a. In cell F19, however, subtract your expenses from the amount IN YOUR BANK 

ACCOUNT, or F4. Your formula should be: =F4-F18. 

b. Now you can use autofill—but make sure you are pulling from the August column, not 

from July. 

8. You will have money accumulating each month—change a few numbers like your student 

loan payment, credit card payment, extras, or other, to use up that money. (For example, you 

may want to money aside for Christmas in November and December.) 

9. Add a header. Print Preview. Print and turn into the basket. 

 
 

Computer Technology 

Assignment 11 
Microsoft Excel 2007 

 
Open Assignment 11 from Student Common/Computer Technology/Spreadsheets. 

 

1. On the tab marked BMR Formula, you will be calculate your Body Mass Index—this will tell 

you how many calories a day you should be eating in order to maintain your weight. 

a. In cell B15, type your height IN INCHES. So, five feet is 60 inches, so if you are, say 5 

foot 6, then you are 66 inches tall. 

b. In cell B17, type your weight in pounds 

c. In cell C18, type your age. 

d. In cell C19, type your activity factor. This is a NUMBER, using the Activity Factor 

guide just below this. 

e. Again, make sure you type a number into this box, not words.

 
2. Now look at the colored boxes at the bottom. If you are male, your BMR is in the blue box. If 

you are female, it is in the red box.  
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a. Go to the Food Chart tab, and type that number in cell B2. 

3.  There are many websites that allow you to calculate your calories—unfortunately they 

require a login and most of them either charge or expect you to be 18. Therefore, I will 

provide information for ten days for you. I have entered it using the website Fitday.com.  

a. We will enter Day 1 together as a class. 

b. You can find days 2-10 on the Daily Intake sheet. DO NOT PRINT THIS SHEET. 

c. Use the information on this sheet to fill out your food log. You need to enter the number 

of calories eaten, and the percentages of Fat, Carbs, and Protein. (from the pie chart) 

4. You should now have your calories for each day entered. You are ready to figure out how 

much OVER or UNDER the daily intakes are from your BMR.  

5. In cell B2 enter your BMR. 

a. In cell C5 do the following formula: =B5-B2. 

i. Now, if you were to use autofill, you would not get the right answers. We need to 

turn B2 into an ABSOLUTE VALUE, so that when we use autofill, it does not 

change.  

ii. Go back to cell C5 and change the formula to =B5-$B$2. Now when you use 

autofill, your math will be correct. 

iii. This is subtracting your BMR from the number of calories you ate that day.  

b. In cell D5, do the following formula: =C5/$B$2. This is figuring a percentage deficit or 

surplus. Change the format on this column to %.   

c. Now you can see if you are eating too much or too little. If you would like to lose weight, 

you want your deficit to be somewhere between 20-30%, no more and no less. If you 

want to gain weight, you need to exceed your calories by at least 10%. 

6. Now look at your fat % column. All of the days where your percentage is higher than 30%, 

change the color to red.  

a. Regardless of how many calories you eat, if your fat percentage is consistently higher 

than 30% you are not eating healthy! 

7. Now let’s graph some of our results! We will be making two charts—one to determine how 

we have done staying within our goal of calories, and the other to determine our total intake 

of fat, protein, and carbohydrates compared to what our intake SHOULD be.  

8. In the Food Chart tab, highlight the percentages for your fats, carbs, and proteins. This 

SHOULD be cells E5-G14 if you have 

ten days. 

a. Copy this, and click on the Graph 

Setup page. Paste it into cell A1.  

b. In cell D1, type ―Fat Goal‖, in E1, 

type ―Carb Goal‖ and in F1 type 

―Protein Goal‖.  

c. Then, in put in the percentage 

you SHOULD be eating of each 

nutrient, as shown. 

9. Highlight A1-F11, and create a Column Chart. Click on the far right option for Chart Layout.  

Change your chart title to Nutrient Intake. 

10. Now, you will change the chart type for some of the items. Looking at your legend, click on 
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the row of columns that corresponds with your Fat Goal. Click on it. Then in the left corner 

choose Change Chart Type. Change it to a line chart, without the dots.  

a. Do the same thing for Carb Goal and Protein Goal. 

b. Last, you are going to change the colors of your remaining bars to match their 

corresponding goal.  

i. In your legend, click on Fats, then 

right click. Change the color by right 

clicking and choosing a color from the 

bucket button. Pick the SAME 

COLOR that is being used for your 

fats goal. 

ii. Do the same for your Carbs and Protein.  

c. Last, move the chart into the graphs tab by highlighting it and choosing Move 

Chart Location on the right side of the Chart Tools bar. 

11. Now you are ready for the second chart. Go back to your Food Chart Tab. 

12. Highlight the dates and the calories, cells A4-B14. Include the titles. Copy them into the 

Graphs Setup tab.  

a. In the next column over, type in your BMR for every day. Your amount of calories 

changes every day, but your BMR stays the same! 

b. Now create a line chart, and call it 

Calories Eaten. It should look like the 

example below.  

c. Move it to the Graphs tab. 

13. Add a Header to each page.  

14. Print Preview to make sure both of your 

graphs take up only one page. 

15. Print your Cover Sheet, Food Log, Graphs 

Setup, and Graphs page. 

Staple and turn in to the basket. 

 

 

 

 
 

Computer Technology 

Assignment 12 
Microsoft Excel 2007 

 
 

For this assignment, you will be using a worksheet handed to you. If you need another copy, you can get 

it from Student Common/Computer Technology/Spreadsheets/Assignment 13. You will learn all about 

how to use a Loan Amortization chart to figure your monthly payments and interest for the purchase of 

large items. 
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Computer Technology 

Assignment 13 
Microsoft Excel 2007 

 
1. Open a new workbook. Create the worksheet below.  

a. Make sure you widen each column to fit the text. 

b. Align the text in the columns to match the worksheet below. 

c. Center the title over the cells. 

d. Change the font on the title to a font of your choice. Change the size to 16. 

e. Compute the total for each person 

f. Compute the Team Average for each game. Do not average the Total column. 

g. Shade the Team Average row to light gray 

h. Format the Team Average for each game as Number with 1 decimal place. 

i. Insert a new column to the left of column B 

j. In cell B3 key : LAST NAME. 

Format this heading like the 

other headings. 

k. In cell A3 change the heading to: 

FIRST NAME 

l. Change the height of row 3 to 

48. 

m. Change the Font of row 3 to 10 

point bold 

2. Wrap the text in each cell of Row 3. 

3. Change the orientation of the text in row 3 to a 45 degree slant from left to right (use the 

alignment tab in Format Cells to do this.) 

4. Highlight A3 to F8 and choose All Borders 

a. Change the alignment in row 3 to center 

b. Beginning in cell B4 to B7, key the following: Simpson, Burns, Mann, Szyslak. 

c. Sort the worksheet alphabetically by Last Name. 

5. Create a Bar Chart for the information in cell B3 to E7.  

a. Title the chart Bowling Team Comparisons. 

b. Place your name as a subtitle below the title. 

6. Now create a Pie Chart. 

a. Highlight the names of the players and the information for totals only. 

b. Create a 3-D pie chart. 

c. Choose a chart layout that will show the percentages. 

d. Title the chart Player Game Totals 

e. Make sure both graphs fit on one page.  

7. Add a header, print preview to ensure it fits on one page, and print. 
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Computer Technology 

Assignment 14 
Microsoft Excel 2007 

 
Go to Computer Technology/Student Common/Computer Technology/Spreadsheets/Assignment 15. 

1. You see a list of students at a high school who owe fines. Do the following: 

a. Center the title and subtitle across the cells 

b. Change the font of the title to size 16, the subtitle to 12. Choose a readable and 

professional font. 

c. Center, Bold, and shade A3-G3. Now we are going to learn how to use Pivot 

Tables. 

2. Place your cursor anywhere in the list, and go to the Insert Ribbon. Click on the Pivot Table button. 

a. From the pull down menu, choose Pivot Table. 

b. You will get a menu that says Create PivotTable. You need to highlight the area where the data 

you need is.  

c. With the menu still on your screen, highlight cells A3-G56 and press ok. 

3. Now you have a new worksheet that looks rather unusual.  

4. On the right side you have a Pivot Table Field List.  

a. This will seem confusing now, but as you work with the pivot 

table, it will begin to make more sense. 

5. Click and drag the following into the areas given. Or, you can right 

click on the field and choose from the list. Do them IN THIS ORDER, 

or it won’t come out right. 

a. Class – Row 

b. Name – Row 

c. Teacher – Report 

d. Gender – Report 

e. Grade – Report 

f. Fine – Values 

g. Paid – Column 

6. It should look like the picture to the left.  

7. Now click on the Questions tab and answer the 10 questions given by using 

the arrow buttons on the pivot chart. Make sure you return the pivot chart to 

it’s unfiltered state between questions. 

8. When finished, make sure you have returned the pivot chart to how it looked 

originally. Print it, and the questions sheet. Staple and turn in to the basket. 

 

 


